SHARE Recruiting

Apply to a Job with a SHARE HCM ID (1 of 12)

SHARE HCM users have a dedicated page to apply to State of New Mexico
jobs directly from SHARE. This job aid shows you how to apply for a job
from your SHARE HCM Homepage: Employee Self Service.

Click > Careers tile from the Employee Self Service page

v Employee Self Service

01‘ imesheet Entry Payroll Personal Details

h

Last Pay Date 04/27/2018

Enter > key words to narrow the job search
Click > Search icon

Search Jobs 9 0
IASD Special Programs Administrative Assistant I » I

Click > Job Title of your interest

Search Jobs a Q

Search Jobs

ASD Special Programs Administrative Assistant 0

Clear Search Save Search

5 jobs found for: "ASD Special Programs Administrative Assistant™
Job Title < Job Ig Location < Agency < ngeteg Close Date =
ASD Special Programs Administrative Assistant (DFA #10114193) I 122106 Santa Fe Department of Finance & Admnst  02/07/2022 Open Until Filled
Administrative Operations Manager II/'Grants Management Bureau Chief (HSD/ASD #7096) 120993 Santa Fe Human Services Department 12/24/2021 Open Until Filled
Grants and Budget Staff Manager (DWS #3375) 120183 Albuguergue Dept of Waorkforce Solutions 11/09/2021  Open Until Filled
Administrative Operations Manager | (HSD/ASD #33141) 119864 Santa Fe Human Services Department 10/29/2021 Open Until Filled
General Manager II- Environmental Protection Division Deputy Director (NMENV/EPD #12085) 118957 Santa Fe Department of Environment 09/07/2021 Open Until Filled
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SHARE Recruiting
Apply to a Job with a SHARE HCM ID (2 of 12)

Review > Job Description details
Click > Apply for Job

¢ Search Jabs Job Desc o
Previous Job ASD Special Programs Administrative Assistant (DFA #10114193) Next Job b
I Apply for Job ' 9
Job ID 122106 FulliPart Time Full-Time
Locafion Santa Fe Regular/Temporary Sponsored Term
Posting End Date Job Posting Type Confinuous Job Opening
Agency Depariment of Finance & Admnst
For more Job Req its & Cl ion:Click Here
¥y Add to Favorite Jobs
=
Salary

§13.98 - 523,63 Hourly
528,249 - 549,135 Annually

This position is a Pay Band 55

Purpose of Position
THIS POSTING WILL BE USED FOR ON-GOING RECRUITMENT AND WILL REMAIN OPEN UNITL FILLED

Why does the job exist?

This position, within the Administrative Services Division will provide high-leve! administrative support to the Director, Deputy Director and Agency Leadership for federal special programs, such as the Emergency Rental
Assistance Program (ERAP). The purpose of this position is to assist with program correspondence, reports. and special projects as requested: financial record keeping and reporfing. accounting, bookkeeping, and
deposits.

How does it get done?

Current ERAP program:

Provide administrative support to Execuives as needed, provide general office support with a variety of clerical activities and related tasks.

Prepares reports; ERAP productivity, award fracking: application stafus

Documenting outgoing and incoming correspondence and retumed payments. Mailing ERA Checks daily, preparing labels for mailing fo \ncalpmpeﬂy addresses
Monitor ERAP personnel correspondence to ASD Director; Provide Assistance with payment issues, process warrant provide o ERA
Assist with processing hotel invoicing and payments.

Update spreadsheets used by accounting. producion, and field services, as requested.

Management of property owners and managers related to the ERAP program

Minimum Qualification
High School Diploma or Equivalent. Substitutions Apply. See Substitution Table below.

Substitution Table

These combinations of education and experience qualify you for the position:

Education Experience
1 High Scheol Diploma or Equivalent AND 2 years of experience
2 Associate's degree or higher (Bachelor's, Master's) AND 0 years of experience

« Education and years of experience must be related to the purpose of the position.

« If Minimum Qualification requires a specific number of "semester hours" in a field (e.g. 6 semester hours in Accounting), applicants MUST have those semester hours in order to meet the minimum
qualifications. No substitutions apply for semester hours.

Employment Requirements
Must possess and maintain a valid New Mexico Driver's License. Must attend state vehicle safety certification program in order to drive museum's cargo van and truck.

TIP: Before applying, make sure you meet the minimum
qualifications for the job.
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SHARE Recruiting

Apply to a Job with a SHARE HCM ID (3 of 12)

Select > Checkbox next to | agree to the Terms and Conditions
Click > Next

X Exit Apply for Job :
ASD Special Programs Admini ive Assi (DFA #10114193) 0
Save as o Next »
i
D Start | Step 1 of 8: Start
In Progress

This step-by-step process will guide you through the application process. You may either include your work experience in the Work Experience section of your
application OR aftach a resume that includes dates of employment for each job (Month & Year). Please complete all information and carefully review before
2 Qualifications submitting

In Progress Prior to submitting your application, please upload any attachments (resumes, transcripts, licenses, certificates etc.) to your profile (My Job Applications =
My Attachments). Once uploaded to your profile, attachments can be used for all job applications and do not need to be added o the Attachments

3 Work Experience section.

Mot Started APPLICATIONS SUBMITTED WITHOUT WORK EXPERIENCE OR A RESUME WILL NOT BE CONSIDERED.

By clicking on the "Accept’ button, | hereby certify that every statement | have made in this application is frue and complete to the best of my knowledge. |
4 Attachments understand:

Not Started
+ Any false or incomplete answer may deem me ineligible for appointment and/or employment;
« Falsifying official records and/or documents such as this employment application may result in termination from employment,
5 References » The State of New Mexico may contact prior employers and references;
Not Started « | may be required o validate all information on this applicafion, |ndud|ng but not limited to NM residency.
« | will be required fo produce decumentation verifying identity and employment eligibility inthe U.S;
» This completed application is the property of the State of New Mexico and will not be returned;
6 Online Questionnaire « | must notify the State of New Mexico Personnel Office of any changes in my name, address, eman or phone number.
Not Started

View Terms and Conditions 0
Self-ldenti
! Not Started W ¥ I'agree to the Terms and Conditions N

TIP: There are seven steps to complete before submitting an
application. If you do not have time to fill out the application in one
sitting, the job posting will save to your profile upon clicking Exit.

Click > Highest Education Level Drop Down
Step 2 of 8: Qualifications

Education History 9

Highest Education Level || A-Not Indicated L

Licenses and Certifications

You have not added any licenses and certifications.

Add Licenses and Certifications
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SHARE Recruiting
Apply to a Job with a SHARE HCM ID (4 of 12)

Select > Education Level

Step 2 of 8: Qualifications

Education History @

Highest Education Level || A-Not Indicated At

Licenses and Certifications A-Not Indicated

B-Less Than HS Graduate
C-HS Graduate or Equivalent
b-Some College

Add Licenses and Certifications E-Technical School
F-2-Year College Dearee
G-Bachelor's Level Degree
H-Some Graduate School
I-Master's Level Degree
J-Doctorate (Academic)
k-Doctorate (Professional)
L-FPost-Doctorate

You have not added any licenses and certificatio

Click > Add Licenses and Certifications (if applicable)

Save a8 Dmft‘ ‘ < Previous Next »

Step 2 of 8: Qualifications
Education History
Highest Education Level = G-Bachelors Level Degree v

Licenses and Certifications

“You have not added any licenses ar ‘ions.

I Add Licenses and Certifications 1

Click > Next
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SHARE Recruiting

Apply to a Job with a SHARE HCM ID (5 of 12)

Click > Add Work Experience

Step 3 of 8: Work Experience

‘When entering your work experience into your application please:

- Indicate within the i you r and/or supervised for each work history entry

- Indicate within the descn'rptinn if you worked part time (less than 40 hours) for each work history entry
- Input an End Date for every job worked. I it is your current job, then you may leave End Date blank

IF SUBMITTING RESUME - WORK EXPERIENCE SECTION DOES NOT NEED TO BE COMPLETED

Work Experience

“You have not added any w @ ance.
| Add Work Experience I

Enter > Required
information

Enter > Description of
your relevant work
experience here. What
were your job duties? What
did you accomplish?

Click > Done

Click > Next

TIP: The State of New
Mexico allows Applicants to
upload their resume, in the
following step. If uploading a
resume, you can skip adding
relevant work experience in
this step..

SHARE

T
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Save as Dmft| | £ Previous II Next 3 I

Cancel

Add Work Experience

=

*Start Date

End Date

*Employer

*Ending Job Title

*Supervisor

Supervisor Email

Supervisor Phone

OK to contact? (

Description

06/20/2011
Maryland Hospital
Security Guard

Harry Smith

hsmith@hospital.com

Yes

5 years experience as a hospital security guard.

Country

Address 1

United States

TIP: Required fields have an asterisk
(*) next to them. At the minimum, fill
out the required fields to continue.
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Apply to a Job with a SHARE HCM ID (6 of 12)

Click > Add Attachment

SaveasDraft| | < Previous || Next 2>

Step 4 of 8: Attachments

Only attach a document here if it is specific to this job posfing. All other documentation (resumes, transcripts, certifications, DD214, etc.) should be aftached
o your profile (My Job Applications = My Altachments) so they can be used for all job applications. If you haven't already afiached documentis to your profile,
you may still do so after the application is submitted

Attachments

‘You have not added any attachments.

| Add Attachment @'

Select > Attachment Type
Enter > Attachment Title
Click > Continue

Cancel Add Attachment Continue @

*Attachment Type = Cover Letters V|I

*Attachment Title Cover Letter @

TIP: Any documents you attach in Step 6 will only be linked to this job
application. Cover Letters are unique to the job and are the only type of
document you should upload in Step 6. All other types of documents (i.e.
Licenses and Certifications, References, Resumes, Transcripts and
Veteran Documents) that are not unique to the job should be uploaded
to your Careers profile.
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SHARE Recruiting

Apply to a Job with a SHARE HCM ID (7 of 12)

Click > My Device

File Attachment X

Choose From

Iy

My Device

-~

Upload @.Iear

Cover Letter.docx
File Size: 11KB

Select > the file to upload from your computer folder

Click > Open
(2 Choose File to Upload X
A m > This PC » Desktop » v O Search Desktop L
Organize ~ New folder E- 1 @

~ Name Date m

# Quick access

Dokt DESKTOP 6/26@
m Desktop
Cover Letter.docx 5/23/c

4 Downloads

@ Veteran.docx 5/28/20
= Documents

= Pictures

File name: Cover Letter.docx v ‘ All Files (*.7) v

| Open I Cancel

Click > Upload
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SHARE Recruiting

Apply to a Job with a SHARE HCM ID (8 of 12)

Click > Done when the upload is complete

File Attachment @
Choose From @

Cover Letter.docx
File Size: 11KB

Upload Complete
]

Click > Done

27

Cancel Add Attachment Done |

*Attachment Type  Cover Letters

*Attachment Title | Cover Letter

Attached File Cover Letter.docx

Click > Next @
SaveastftH < Previous jl Next )I

Step 4 of 8: Attachments

Only attach a document here I it is specific to this job posting. All other documentation (resumes, transcripts, certifications, DD214, etc.) should be attached
to your profile (My Job Applications = My Attachments) so they can be used for all job applications. If you haven't already attached documents to your profile,
you may still do so after the application is submitied

Attachments

+
Attached File Attachment Title Attachment Type
Cover_Letter docx Cover Letter Cover Letters >
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SHARE Recruiting

Apply to a Job with a SHARE HCM ID (9 of 12)

Click > Add Reference

Save as Draft

| < Previous

Next 3 I

Step § of 7: References

References

You have not added @'&r&n:es.
Add Reference I

Enter > Required information
Click > Done
Click > Next

TIP: You may add both professional and personal references. If you

Cancel

Edit Reference

Done

Reference Information

*Reference Type

*Reference Name

*Title

Employer

Phone

Email Address
Address

Country

Address 1

Address 2

Address 3

city

Professional ﬂ
Harry Smith

Supervisor

hsmith@hospital.com

United States

ull

S

previously applied for a job, the references will automatically appear here.

You may add as many references as you believe are necessary for the

application.
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SHARE Recruiting

Apply to a Job with a SHARE HCM ID (10 of 12)

Select > Radio buttons under each question to complete the Online
Questionnaire

Click > Next

34

Apply for Job Aol < Previous Next 3 i

33)

Step 5 of 7: Online Questionnaire
Questionnaire (Required)

1. Do you meet the minimum qualifications of High School Diploma or Equivalent? Substitutions may apply. Please refer to Substitution Table on
the Job Posting.

O Yes
O No
2. How many years of experience do you have assisting in training employees on agency safety, security, loss control programs, fire safety, and
disaster planning, and hazardous materials emergency response?
O None
O One to three years
O Four to six years
O Seven to nine years

O Ten or more years

3. Are you a resident of the State of New Mexico?
O Not a Resident
O Resident greater than or equal to 1 year
O Resident greater than or equal to 2 years
O Resident greater than or equal to 3 years
© Resident greater than or equal to 4 years

O Resident greater than or equal to 5 years

TIP: Complete the Online Questionnaire prior to
submitting the application. These questions assess if
you meet the required qualifications for the job.
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SHARE Recruiting

Apply to a Job with a SHARE HCM ID (11 of 12)

TIP: Review your application and
make changes in Step 7 if
necessary.

Click > Submit

Apply for Job - K Previousl Submit @

Review your application and make any changes before submitting.

Step 7 of 7: Review and Submit

w My Contact Information

Email share.test@state.nm.us Address 9865 Wishing Apple Subdivision, Santa Fe, NM
87507

Phone
Contact Method

Modify

P Online Screening Notice

b Attachments

» Work Experience

» Degrees

P Licenses and Certifications

» References

SHARE
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SHARE Recruiting

Apply to a Job with a SHARE HCM ID (12 of 12)

After submitting an application, you receive immediate notification if you
met the minimum qualifications for the job. The message appears under
Online Screening Results.

Application Confirmation

You have i your job

Jobs Applied For
Job Title ASD Special Programs Administrative Assistant (DFA#10114193) Posting Date 02/07/2022
JobID 122106 Application Date 03/03/2022
Location Santa Fe

Online Screening Results

Job Title ASD Special Programs Adminisirative Assistant (DFA#10114193) JobID 122106
We are pleased to let you know that your job application has been accepted for further consideration. You may review your submitted applicafion through your Careers Profile under My Job Applications. Please note that
any false or incorrect information will invalidate this application

# Careers

(& View Submitted Application
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